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Foreword 
 
Utah Division of Water Quality (DWQ) Standard Operating Procedures (SOPs) are 
adapted from published methods, or developed by in-house technical experts.  This 
document is intended primarily for internal DWQ use. This SOP should not replace any 
official published methods. 
 
Any reference within this document to specific equipment, manufacturers, or supplies is 
only for descriptive purposes and does not constitute an endorsement of a particular 
product or service by DWQ. Additionally, any distribution of this SOP does not constitute 
an endorsement of a particular procedure or method. 
 
Although DWQ will follow this SOP in most instances, there may be instances in which 
DWQ will use an alternative methodology, procedure, or process. 
 
The methodology detailed below is the protocol followed by DWQ’s monitoring staff and 
verified by DWQ’s Quality Assurance officer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
_________________________________   _____________________              
Benjamin R. Brown      Date 
Monitoring Section Manager 
 
 
 
 
_________________________________   _____________________ 
Toby Hooker       Date 
Quality Assurance Officer 
 

Signature:

Email:

Signature:

Email:

Toby Hooker (Feb 7, 2022 10:21 MST)
Toby Hooker
tobyhooker@utah.gov

Benjamin Brown (Feb 7, 2022 10:23 MST)
Benjamin Brown

brbrown@utah.gov

https://utahgov.na1.echosign.com/verifier?tx=CBJCHBCAABAAcx3Gglmn34jWLOIeTMrwaEuRKgUx7a59
https://utahgov.na1.echosign.com/verifier?tx=CBJCHBCAABAAcx3Gglmn34jWLOIeTMrwaEuRKgUx7a59
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Revision Page 
 

Date Revision # Summary of Changes Sections Other Comments 
5/1/14 0 not applicable not 

applicab
le 

New SOP.  Began document 
control/revision tracking. 

4/14/20 1 Updated language, 
grammar, and structure
  

All  Clarified and revised sentence 
structure and grammar 
throughout the entire 
document. 

4/24/20 1.1 Added baroTROLL 
language and clarified 
amount of flow 
measurements needed 

All Updated procedure to ensure a 
baroTROLL is installed 
alongside a PT. Related 
amount of flow measurements 
to strength of the curve. 

2/1/22 1.2 Clarified and updated 
language, grammar and 

structure 

All  

2/1/22 1.2 Added Appendix 4 14 Quick Deployment Guide 
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1.0 SCOPE AND APPLICABILITY 

This document presents the Utah Division of Water Quality’s (DWQ) Standard Operating 
Procedure (SOP) for the installation and maintenance of pressure transducers in Utah’s natural 
(rivers, streams, lakes) or engineered (ditches, canals, reservoirs) surface water bodies.  This SOP 
applies to any DWQ monitor or cooperator installing or maintaining pressure transducers. This 
SOP also outlines the responsibilities of DWQ monitors to perform inspections of pressure 
transducers and associated equipment while collecting water samples or performing flow 
measurements at a site where a pressure transducer has been installed. 

In-situ Level TROLL® pressure transducers are a low-cost and robust method of determining near-
continuous flow in streams that are not gaged by another agency (such as the US Geological 
Survey).  The pressure transducer consists of an “absolute” or “uncompensated” pressure sensor 
that measures absolute pressure and is not vented to allow for compensation for atmospheric 
pressure.  Therefore, atmospheric pressure is subtracted from the absolute measurement to 
determine the pressure from water.  The determination of atmospheric pressure at a site is often 
done with an In-situ baroTROLL® logger, however, data from nearby weather stations can be 
used in some situations. The pressure transducer will log the depth of water at set time intervals.  
Recorded values are stored in the sensor itself and are periodically retrieved by field personnel.  
By combining these logs of depths with a number of discharge measurements taken at the site, a 
rating curve can be developed, correlating the depth of water with the measured discharge.  Once 
this correlation has been established, discharge may be inferred from water depth alone. In order 
to establish a strong rating cure, flow measurements need to be taken at the site of the 
pressure transducer across a range of flow conditions.  

Flow data is used by DWQ scientists and engineers for a variety of purposes including but not 
limited to:  

• understanding the effect of hydrologic condition on aquatic life uses 
• determining pollutant loading and inputs into waterbodies 
• setting permit requirements for discharge of treated wastewater 
• understanding groundwater/surface water interactions 
• characterizing current water quality conditions and detecting long-term trends 

The information discussed in this SOP is not a substitute for equipment user manuals or other 
technical documentation.  Consult the appropriate manual for a complete guide to the proper use, 
calibration, maintenance, deployment, and troubleshooting of a particular brand of pressure 
transducer equipment/software.  This SOP is to be used as a reference but the complete user manual 
should always accompany field personnel.   

2.0 SUMMARY OF METHOD 

The transducers are programmed to log the depth of water every 15 minutes (can be in any 
increment of time).  Prior to installation, the site will be scoped for feasible placement of the 
transducer inside a PVC pipe. Ensure that the bottom of the pipe is as close as possible to the low-
water level of the stream and the top of the pipe as close as possible to the expected high water 
level. In order to retrieve data, the pressure transducer must be accessible (i.e., cannot be 
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downloaded remotely).  The PVC pipe will act as a stilling well to even out the wave action of the 
flowing water, and to prevent damage to the transducer by natural causes or intentional damage.  
The pipe will be installed using one of a number of methods to safeguard against high flows and 
vandalism. Typically, a baroTROLL® or some other method of atmospheric pressure correction 
is required at each pressure transducer site and should be described in detail in the project-specific 
SAP.  After installation, streamflow measurements should be taken using the procedures detailed 
in Utah DWQ’s SOP for Stream Flow Measurements.  

3.0 DEFINITIONS 

BaroTROLL®: An atmospheric pressure measuring device that is manufactured by In-
situ®. It is used alongside a transducer to correct for offsets in 
atmospheric pressure. 

Discharge: A term used in this SOP interchangeably with “flow.”  This is the 
volume of water flowing per unit of time.   

Gaging station: This is a site where flow is being measured continuously and 
automatically using devices such as, but not limited to, pressure 
transducers. 

Pressure transducer: A device that measures pressure. Sometimes referred to as a “PT” or a 
“transducer.” 

PVC pipe: Polyvinyl chloride pipe. 

Q-boat:  Acoustic Doppler current profiler (ADCP) is a device used by DWQ to 
measure discharge at non-wadeable sites. 

Reference level: The fixed elevation or height under the water at which the pressure 
transducer is installed 

Stage: The height of the surface of the water in relation to the reference level 

Stilling well: A cylinder installed near a body of water used to hold and protect 
hydrological sensors.  The stilling well allows water to move in and out 
freely to interact with sensors but dampens wave and current action so 
as to provide a representative water level and to reduce noise in water 
level data. 

4.0 HEALTH AND SAFETY WARNINGS 

Hazardous conditions potentially exist at every waterbody.  If unfavorable conditions are present 
at the time of sampling, it is recommended that the sampling be rescheduled.  If hazardous 
conditions arise during sampling, such as lightning, high winds, rising water, or flash flood 
warning, personnel should cease sampling and move to a safe location. 
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When working in Utah and other warm climates, take steps to avoid heat induced illnesses such as 
heat stroke or heat exhaustion. 

Use caution when working in waders as drowning hazards exist. 

Take appropriate precautions when operating equipment and working on, in, or around water, as 
well as possibly steep and unconsolidated banks, rip rap, bridges, or edges of ponds/lagoons.   All 
field crews should follow DWQ health and safety procedures and be equipped with safety 
equipment such as proper wading gear, personal flotation devices (PFDs), gloves, first aid kits, 
cellular phone, etc.  

Use caution when sampling from a bridge or boat and take appropriate actions to make the situation 
as safe as possible; suspend the sampling if conditions are unsafe. 

Power tools can be hazardous if used improperly.   

5.0 CAUTIONS 

No additional cautions for this procedure. 

6.0 INTERFERENCES 

Since the pressure transducer relates recorded depth of the transducer to recorded flow at the site, 
it is imperative that the elevation of the transducer remains at reference level for the duration of 
measurements.  The transducer will need to be removed from the PVC pipe to download data and 
to clean out any debris or sediment, and then reinstalled at the same level from which it was 
retrieved. Any deviations of transducer elevation from reference level must be documented 
in project-specific field notebooks and pressure transducer tracking sheet. 

The PVC pipe must be anchored firmly to prevent movement, which would change the reference 
depth of the transducer. Anchor PVC pipe in an area that won’t be affected by extreme flow events. 

Avoid backwater conditions. For example, if the system has a heavy influence from beavers, find 
an area that is not conducive to beaver dam construction.  If the area where the transducer is local 
is in the backwater from a beaver dam, the water surface elevation will not reflect a higher flow 
and your stage-discharge relationship will be affected erroneously. 

If the transducer is buried in sediment (caused by any change in channel shape), it will measure 
erroneous values and your stage-discharge relationship will be affected.  

A strong stage-discharge relationship requires an abundance of flow measurements; however, 
conditions and logistics may inhibit the amount of flow measurements taken. Therefore, flow 
measurements recorded at the site should be as accurate as possible to ensure a strong relationship. 

7.0 PERSONNEL QUALIFICATIONS/RESPONSIBILITIES 

A Utah DWQ monitoring staff member will have primary responsibility for installation of pressure 
transducers, PT data collection, and development/maintenance of rating curves. Personnel 
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installing pressure transducers and taking flow measurements should be knowledgeable of the 
relation between stream depth, or stage, and stream flow.  Programming the transducers requires 
knowledge of computers and deployment software.  Installation of the stilling wells and 
transducers is physically demanding and requires the use of a T-post driver, 3 pound hammer, 
hammer drill, and cable cutters. 

DWQ personnel performing water sampling must be familiar with sampling techniques, safety 
procedures, proper handling, and record keeping.  Samplers are responsible for attending refresher 
meetings held each spring/summer to review procedures and techniques.  New staff will be trained 
in the field and lab by DWQ personnel. 

Cooperators are required to read this SOP annually and acknowledge they have done so via a 
signature page (see Appendix 1) that will be kept on-file at DWQ along with the official hard copy 
of this SOP.    

8.0 EQUIPMENT AND SUPPLIES 

❏ Copy of this SOP 
❏ PT Tracking Form (Appendix 2) 
❏ In-situ Level TROLL® logging pressure transducer or equivalent. 
❏ Win-Situ® 5 logger software 
❏ In-situ® USB TROLL Com Direct Connect communication cable 
❏ Laptop or desktop computer to communicate with the Level TROLL® 
❏ 1.5-in PVC Schedule 40 electrical conduit pipe, 10-ft length cut to fit  installation 
❏ Two 1.5-inch PVC caps 
❏ 3/32-inch vinyl coated braided stainless-steel (SS) cable; cut to fit specific installation 
❏ 3/32-inch cable ferrules to attach SS cable to pressure transducer 
❏ Attachment materials and tools: 

❏ ¾-inch SS strapping, seals, and tensioner 
❏ Hammer drill, 3/32-inch masonry bits, ¼-inch X 2-inch masonry screws 
❏ Power-actuated nailer, power charges, and concrete pins 
❏ 1.5-inch two-hole metal conduit straps 
❏ 5-foot T-posts, post driver, 3 pound single jack sledgehammer, 2-foot rebar 

❏ Combination padlock to secure the transducer on the SS cable in the PVC pipe  
❏ In-situ BaroTROLL® (may be unnecessary depending on geographic area) 

9.0 PROCEDURE 

9.1 Calibration and Pre-installation Procedure 

1. The In-situ Level TROLLs® are calibrated at the factory and no calibration or 
standardization is necessary before use. Record the serial number and factory calibration 
date for the pressure transducer on the electronic tracking form (see Appendix 2) 
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2. The life of a transducer and how long it will maintain its calibration is dependent upon the 
duration of use, exposure to extreme environmental conditions, and how carefully it is handled 
during storage, transportation, and use.  If needed, calibration is possible with the Level 
TROLL® and the procedure is detailed in the Level TROLL® Operators Manual (link found 
in Section 12). 

3. Prior to installation, coordinate with Marshall Baillie, DWQ Monitor, to document PT 
information and site installation details. 

9.2 Installation 

1. Determine where detailed flow measurements are required and assess the best location to 
install the stilling well and transducer.  The stilling well should be mounted to a permanent 
object (e.g., bridge piling) at a location where the channel cross section is not likely to change 
over time.  In addition, this location should be suitable for obtaining discharge measurements 
by wading or deploying a Q-boat from a bridge or cable.  

Note: The location for the pressure transducer should avoid areas with: influence of beaver, 
backwater, sediment build-up, and change in channel cross section. 

2. Using Win-Situ® 5 software, program the transducers to log depth readings every 15 minutes, 
using the procedure outlined in the software. The Level TROLLs can be programmed to log 
immediately, or a delayed start may be used.  In either case, ensure in the software that the unit 
is programmed and is logging or will begin logging at the programmed time and date.  Include 
in the programming the name of the site and date of deployment. 

3. Based upon the site, determine the length of the PVC pipe that will reach down to low water 
and ideally above high water.  The transducers are water-tight, so no damage will occur if the 
top of the pipe is not above water throughout the year, however the accuracy of results will be 
compromised. 

4. Using this determined length, cut the PVC pipe to the appropriate length.   

5. Drill a 3/8 in hole for the padlock 2 inches below the top of the PVC pipe.  

6. Drill several holes near the bottom of the PVC pipe to allow for water flow through the system. 
Also drill holes to insert another bolt. The bolt will be the seat for the PT when deployed.   

7. Using the 3/32 in SS cable and ferrules, make a tether for the pressure transducer inside the 
PVC pipe (See Figure 1 and Figure 2 for a view of this setup). 

a) Place a ferrule on the cable, run the end through the eyelet on the top of the transducer 
then through the ferrule again, forming approximately a 2 in loop.  Clamp in place using 
an assuage tool or the 3-pound sledge and a hard surface. 

b) To determine the location and length of the cable for the transducer in the stilling well: 
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i) Lower the transducer into the pipe from the top until the PT hits the bolt at the bottom 
of the stilling well.   

ii) Pull the transducer up approximately ½ in above the top and mark the cable at the 
location of the 3/8 inch hole in the pipe for the padlock.   

iii) Form a loop with this mark at the top, and cut the cable with adequate length to make 
this loop.  

iv) Verify that the transducer will be approximately ½ in above the bottom cap when the 
padlock is run through the pipe and top loop of the tether, and secure the loop with a 
ferrule (See Figure 3).  

8. Secure the transducer inside the stilling well by inserting the free end of the padlock shackle 
through one of the 3/8 in holes at the top of the well, hooking the tether loop over the shackle 
inside the pipe, then inserting the shackle through the other hole (other side of pipe) and locking 
the padlock (See Figure 1).  

9. Place the top cap on the stilling well. 

10. To attach the stilling well at the determined site, it must be attached so that it will not be 
dislodged in any high flow events. Below are some examples of different set-ups, however 
depending on site-specific information, other techniques may need to be used. See Figures 
section for a visual of these set-ups. 

a) If using a bridge pylon or other vertical structure that extends into the stream as low as the 
low watermark, the stilling well can be strapped to the downstream side (to minimize wakes 
caused by the structure). See Figure 2. 

b) If using a vertical surface, such as a bridge abutment at the downstream side where the SS 
strapping cannot be wrapped around the surface, the 1.5 in metal conduit straps can be used 
to attach the stilling well.  If the vertical surface is concrete, a hammer drill and concrete 
screws or powder-actuated nailer and concrete nails will be used to attach the stilling well, 
nailing or screwing down the straps over the stilling well in at least two spots, typically just 
above the current water level and near the top of the well. See Figure 4. 

c) If no vertical surface is present, the transducer can be attached to a diagonal surface, such 
as a stream bank.  The transducer records absolute depth of water, so the stilling well in a 
diagonal position will not affect readings.  The stilling well could be attached to T-posts, 
sections of rebar, or a tree root in the stream bank. Attach the stilling well using the SS 
strapping around the well and post to prevent movement. See Figure 5. 

11. A baroTROLL® should be installed along with the pressure transducer. Some sites may not 
need a baroTROLL® installed alongside a transducer. Refer to the project-specific SAP for 
more site-specific information. See Figure 6 for a baroTROLL® setup. 

12. Record the date of deployment on the PT tracking form (Appendix 2). 
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9.3 Flow Measurements 

In order to establish a strong rating curve, an abundance of flow measurements at the site of the 
transducer must be taken. Ideally these flow measurements would be taken on a monthly basis, 
but the following considerations need to be taken into account: 

• A strong rating curve is based on the flow measurements at a variety of flow conditions. 
Therefore flow measurement sampling should be targeted to measurements of high, 
regular, and low flow. 

o This is an iterative process that is influenced by the data relationship. For 
example, if the relationship is lacking low flow measurements, the field monitor 
should be sure to obtain flow measurements during a lower flow period.  

Any additional information about flow measurement frequency can be found in the project-
specific SAP and at the discretion of the DWQ Monitor sampling. 

9.4 Inspection and Maintenance 

1. The transducers should be inspected whenever feasible to ensure no damage, shifting, or 
vandalism has occurred.  Monitors perform a visual inspection of the gage each time they visit 
that site.  In addition, the monitor responsible for maintaining DWQ’s gaging stations may 
visit the site to perform inspections and maintenance at more frequent intervals. 

2. The monitor responsible for maintaining DWQ’s gaging stations will determine the frequency 
at which more detailed inspections of the pressure transducer and inside of the stilling well 
will be performed.  The transducer can be removed from the well to remove debris or sediment 
and the pressure transducer and stilling well can be cleaned.  At a minimum, a detailed 
inspection and maintenance should be performed during data retrieval. 

3. Record that an inspection and/or maintenance was performed on the PT Tracking document 
(Appendix 2). 

4. See Figure 7 for a guide to troubleshooting transducer installation and maintenance. 

9.5 Data Retrieval 

1. To retrieve the pressure transducer, remove the PVC cap and unlock the padlock.  Pull on the 
SS cable to lift the pressure transducer out of the pipe. 

2. To download the data, remove the protective cap from the transducer and plug it into the laptop 
using the RS232 Direct Connect cable.  Win-Situ® 5 will recognize the instrument, and prompt 
the user to connect and download the data. 

3. Make certain the transducer is once again logging at the 15-minute intervals, and reinsert into 
the stilling well, attaching the tether with the padlock.  The 2 inch loop ensures that the pressure 
transducer is lowered to the same depth from which it was retrieved. 

4. Record that data retrieval was performed on the field form (Appendix 2). 
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5. Upload data to the DWQ server at this link:  

U:\PERMITS\MONITORS\YEAR_wy_Data\YEAR_wy_PressureTransducerData 

For more information on the data retrieval process, see the operating manual from In-situ® 
(Section 12.0) 

9.5 Long-Term Deployments 

For long-term deployments, changes in channel cross-sections must be taken into account. Any 
additional information on this will be detailed in the project-specific SAP. 

10.0 DATA AND RECORDS MANAGEMENT 

• The PT tracking form in Appendix 2 should be included in the site portfolio of every site 
where a pressure transducer has been installed.  Use this form to record installation of the 
pressure transducer, inspections and maintenance performed and data retrievals performed. 
Make note of any elevation changes for the transducer as they need to be accounted for 
during the data review process. 

• There is an electronic PT data tracking form (Appendix 3) to detail where the download 
transducer data is located, and where the flow measurement data is located.  Any flow 
measurement, if performed for DWQ sampling, has a file where flow measurements are 
recorded. Upon returning to the office with downloaded transducer data, the file should be 
uploaded on the Utah DWQ server as a backup, found at this link: 
U:\PERMITS\MONITORS\YEAR_wy_Data\YEAR_wy_PressureTransducerData 

• The Win-Situ® 5 software will store the logged depths and the logged barometric 
pressures. In-situ® Inc.’s Baro Merge Software will compensate the logged depths for 
changes in barometric pressure, improving accuracy. 

• The BaroTROLL® is identical to the Level TROLL® except it is deployed in the air.  The 
BaroTROLLs® record barometric pressure every 15 minutes, and should be downloaded 
the same way as well, at the same time as the Level TROLLs®. 

• Using flow determinations and the logged depth at the time of flow measurement, a stage-
discharge rating curve will be created.  From the curve, an equation can be made that will 
allow all of the logged depths to be converted into flow estimations.  Generally, flow 
measurements are performed each time monitors collect water samples; however, pressure 
transducer sites can be independent of sampling sites. If this is the case, only flow 
measurements need to be taken, if conditions allow.   

• The monitor responsible for maintaining DWQ’s gaging stations will determine the 
frequency at which flow measurements performed specifically for rating curve 
assessments/adjustments need to be performed.  See Section 9.3 for more information.  
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11.0 QUALITY ASSURANCE AND QUALITY CONTROL 

Follow all procedures described in this SOP to ensure valid, high quality pressure transducer 
measurements.  Follow all procedures described in DWQ’s SOP for Stream Flow Measurement to 
ensure valid, high quality flow measurements that can be used to develop rating curves for gaged 
sites. 

Keep up-to-date equipment maintenance records and calibration data (Appendix 2) with other site 
records to provide defense of quality data from installed pressure transducers. 

12.0 REFERENCES 

The In-situ® website (http://www.in-situ.com/) has Win-Situ® software updates and helpful 
Quick Guides, Instrument Manuals, Instruction Sheets and Technical Notes including: 

• Level TROLL  Operator's Manual (https://in-situ.com/us/rugged-troll-100) 
• Win-Situ® 5.0 User’s Guide  
• Technical Note: Using Baro Merge Software  

o (https://in-situ.com/us/support/categories/software-firmware) 
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investigations." US Geological Survey, Techniques of Water-Resources Investigations 8 (2004): 
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10/28/2009. Online at http://www.lanl.gov/environment/all/ docs/qa/ep_qa/SOP-5227.pdf. 
 
U.S. Environmental Protection Agency (EPA). 2014. Best Practices for Continuous 
Monitoring of Temperature and Flow in Wadeable Streams. Global Change Research Program, 
National Center for Environmental Assessment, Washington, DC; EPA/600/R-13/170F. Available 
from the National Technical Information Service, Springfield, VA, and online at 
http://www.epa.gov/ncea. 
 
Yerington Mine Site. 2009. Pressure transducer water level monitoring standard operating 
procedure SOP-21, Revision 1, Revision Data 4/28/2009.  Online at 
http://yosemite.epa.gov/r9/sfund/r9sfdocw.nsf/cf0bac722e32d408882574260073faed/120f26eb0
d420d8b882575e1006899ae/$FILE/SOP-21r1%20Pressure%20Transducer 
%20Water%20Level%20Monitoring.pdf. 
 
Related DWQ SOPs:  Standard Operating Procedures for Stream Flow Measurement 
 
 
 
 

http://www.in-situ.com/
https://in-situ.com/us/rugged-troll-100
https://in-situ.com/us/support/categories/software-firmware
http://www.lanl.gov/environment/all/%20docs/qa/ep_qa/SOP-5227.pdf
http://yosemite.epa.gov/r9/sfund/r9sfdocw.nsf/cf0bac722e32d408882574260073faed/120f26eb0d420d8b882575e1006899ae/$FILE/SOP-21r1%20Pressure%20Transducer%20%20Water%20Level%20Monitoring.pdf
http://yosemite.epa.gov/r9/sfund/r9sfdocw.nsf/cf0bac722e32d408882574260073faed/120f26eb0d420d8b882575e1006899ae/$FILE/SOP-21r1%20Pressure%20Transducer%20%20Water%20Level%20Monitoring.pdf
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Page 14 of 22 

13.0 FIGURES 

Figure 1: Top view of installed pressure transducer.  

 

Figure 2: View of a pressure transducer attached to a metal sign. 
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Figure 3: View of pressure transducer with clamped ferrules. 

 

Figure 4: View of pressure transducer attached to a bridge 
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Figure 5: View of a pressure transducer attached to a tree root. 
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Figure 6: View of a baroTROLL® attached to a nearby tree. 
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Figure 7: Troubleshooting Guide. Taken from EPA, 2014. 
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14.0 APPENDICES 

APPENDIX 1 - SOP ACKNOWLEDGMENT AND TRAINING FORM 

SOP Acknowledgement Form 

This SOP must be read and acknowledged annually, and this form must be kept on file at DWQ.  
 

Document Title:  

Document Revision Number:  

Document Revision Date:  

 
Please sign below in accordance with the following statement:                                                

“I have read and understood the above referenced document.  I agree to perform the 
procedures described in this SOP in accordance with the document until such time that it 
is superseded by a more recent approved revision.” 

Date  Printed Name Signature 
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SOP Training Form  
Training is required for all new samplers and Refreshers are required annually.  

Trainee:  Sign below to acknowledge that training on this SOP was received, understood, and all 
questions/concerns were addressed by the trainer. 

Trainer:  Sign below to acknowledge that training on this SOP was completed for the individual 
listed and that trainee is competent to perform the procedures described within. 
 

Date  Trainee Printed Name Trainee Signature Trainer Printed Name Trainer Signature 

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

     

Management Approval 

Printed Name: 

Signature: 

Date: 
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Appendix 2: Example. Pressure transducer tracking form 
 

 
 

Appendix 3: Example. Pressure transducer data tracking form 
 

 

 

Appendix 4: Quick Deployment Guide 
PT deployment Instructions 

Setting the Instrument Time 

The instrument time and the current PC time are shown at the top of the screen when an 
instrument is connected to the software. The PC time appears on the left, the instrument 
time on the right. Both clocks are updated at 0.5 Hz (once every two seconds). The 
device time is displayed in red if it differs by more than a few seconds from the 
current PC time. Data logging schedules depend on the correct instrument time. 

To synchronize the instrument time to the current PC time, click the Clock Sync button. 
Win-Situ writes the current PC time to the instrument. 

Adding a New Site 

To add a new site to the site database in your working directory do one of the following: 
On the Data tab, click the Site Data folder, select File> New > Site. 
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Or 

On the Home tab, click the Site button  to display the site list, then click New. Enter a 
name for the site. This is the only required field. 

Click Save to save the new site. The new site will appear in the Site Data folder, and 
Win-Situ will add it to the site database in the working directory on your computer. It is 
now available to select for any instrument log. 

Log Setup 

The Log Setup Wizard presents sequential screens to help you supply all the information 
necessary to set up a data log in the instrument. 

To access the Log Setup Wizard the instrument must be connected to the software. 

1. Click the Logging tab  

2. Click the New button . 

The New button may be disabled or may show a warning if an active log already exists 
on the instrument, or if the instrument is polling live data (see the Home screen), or if the 
device already contains its maximum number of logs. 

3. Select the Site where the set of data will be logged and supply a name for the log. 

4. Click the right arrow to continue after each following step, 5-9. 

5. Select the parameters you intend to measure (Pressure in mmHg, Depth in feet, and 
Temp in Celsius). 

6. Select the logging method (linear) you intend to use. 

7. Select the log interval (15min). A log interval is how often a measurement will be 
taken and stored. 

8. Select the start condition (a time in the near future), stop condition (usually none), 
and specify how to handle full device memory (do not overwrite data). 

9. If you selected depth as a parameter to measure, specify how you intend to log this 
parameter (depth mode does not require that you enter a Level Reference). 

10. The final screen summarizes the log setup. Click the checkmark to write this 
information to the instrument. 

11. Deploy the device in the stilling well. 
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	1.0 SCOPE AND APPLICABILITY
	This document presents the Utah Division of Water Quality’s (DWQ) Standard Operating Procedure (SOP) for the installation and maintenance of pressure transducers in Utah’s natural (rivers, streams, lakes) or engineered (ditches, canals, reservoirs) su...
	In-situ Level TROLL® pressure transducers are a low-cost and robust method of determining near-continuous flow in streams that are not gaged by another agency (such as the US Geological Survey).  The pressure transducer consists of an “absolute” or “u...
	Flow data is used by DWQ scientists and engineers for a variety of purposes including but not limited to:
	 understanding the effect of hydrologic condition on aquatic life uses
	 determining pollutant loading and inputs into waterbodies
	 setting permit requirements for discharge of treated wastewater
	 understanding groundwater/surface water interactions
	 characterizing current water quality conditions and detecting long-term trends
	The information discussed in this SOP is not a substitute for equipment user manuals or other technical documentation.  Consult the appropriate manual for a complete guide to the proper use, calibration, maintenance, deployment, and troubleshooting of...
	2.0 SUMMARY OF METHOD
	The transducers are programmed to log the depth of water every 15 minutes (can be in any increment of time).  Prior to installation, the site will be scoped for feasible placement of the transducer inside a PVC pipe. Ensure that the bottom of the pipe...
	3.0 DEFINITIONS
	BaroTROLL®: An atmospheric pressure measuring device that is manufactured by In-situ®. It is used alongside a transducer to correct for offsets in atmospheric pressure.
	Discharge: A term used in this SOP interchangeably with “flow.”  This is the volume of water flowing per unit of time.
	Gaging station: This is a site where flow is being measured continuously and automatically using devices such as, but not limited to, pressure transducers.
	Pressure transducer: A device that measures pressure. Sometimes referred to as a “PT” or a “transducer.”
	PVC pipe: Polyvinyl chloride pipe.
	Q-boat:  Acoustic Doppler current profiler (ADCP) is a device used by DWQ to measure discharge at non-wadeable sites.
	Reference level: The fixed elevation or height under the water at which the pressure transducer is installed
	Stage: The height of the surface of the water in relation to the reference level
	Stilling well: A cylinder installed near a body of water used to hold and protect hydrological sensors.  The stilling well allows water to move in and out freely to interact with sensors but dampens wave and current action so as to provide a represent...
	4.0 HEALTH AND SAFETY WARNINGS
	Hazardous conditions potentially exist at every waterbody.  If unfavorable conditions are present at the time of sampling, it is recommended that the sampling be rescheduled.  If hazardous conditions arise during sampling, such as lightning, high wind...
	When working in Utah and other warm climates, take steps to avoid heat induced illnesses such as heat stroke or heat exhaustion.
	Use caution when working in waders as drowning hazards exist.
	Take appropriate precautions when operating equipment and working on, in, or around water, as well as possibly steep and unconsolidated banks, rip rap, bridges, or edges of ponds/lagoons.   All field crews should follow DWQ health and safety procedure...
	Use caution when sampling from a bridge or boat and take appropriate actions to make the situation as safe as possible; suspend the sampling if conditions are unsafe.
	Power tools can be hazardous if used improperly.
	5.0 CAUTIONS
	No additional cautions for this procedure.
	6.0 INTERFERENCES
	Since the pressure transducer relates recorded depth of the transducer to recorded flow at the site, it is imperative that the elevation of the transducer remains at reference level for the duration of measurements.  The transducer will need to be rem...
	The PVC pipe must be anchored firmly to prevent movement, which would change the reference depth of the transducer. Anchor PVC pipe in an area that won’t be affected by extreme flow events.
	Avoid backwater conditions. For example, if the system has a heavy influence from beavers, find an area that is not conducive to beaver dam construction.  If the area where the transducer is local is in the backwater from a beaver dam, the water surfa...
	If the transducer is buried in sediment (caused by any change in channel shape), it will measure erroneous values and your stage-discharge relationship will be affected.
	A strong stage-discharge relationship requires an abundance of flow measurements; however, conditions and logistics may inhibit the amount of flow measurements taken. Therefore, flow measurements recorded at the site should be as accurate as possible ...
	7.0 PERSONNEL QUALIFICATIONS/RESPONSIBILITIES
	A Utah DWQ monitoring staff member will have primary responsibility for installation of pressure transducers, PT data collection, and development/maintenance of rating curves. Personnel installing pressure transducers and taking flow measurements shou...
	DWQ personnel performing water sampling must be familiar with sampling techniques, safety procedures, proper handling, and record keeping.  Samplers are responsible for attending refresher meetings held each spring/summer to review procedures and tech...
	Cooperators are required to read this SOP annually and acknowledge they have done so via a signature page (see Appendix 1) that will be kept on-file at DWQ along with the official hard copy of this SOP.
	8.0 EQUIPMENT AND SUPPLIES
	❏ Copy of this SOP
	❏ PT Tracking Form (Appendix 2)
	❏ In-situ Level TROLL® logging pressure transducer or equivalent.
	❏ Win-Situ® 5 logger software
	❏ In-situ® USB TROLL Com Direct Connect communication cable
	❏ Laptop or desktop computer to communicate with the Level TROLL®
	❏ 1.5-in PVC Schedule 40 electrical conduit pipe, 10-ft length cut to fit  installation
	❏ Two 1.5-inch PVC caps
	❏ 3/32-inch vinyl coated braided stainless-steel (SS) cable; cut to fit specific installation
	❏ 3/32-inch cable ferrules to attach SS cable to pressure transducer
	❏ Attachment materials and tools:
	❏ ¾-inch SS strapping, seals, and tensioner
	❏ Hammer drill, 3/32-inch masonry bits, ¼-inch X 2-inch masonry screws
	❏ Power-actuated nailer, power charges, and concrete pins
	❏ 1.5-inch two-hole metal conduit straps
	❏ 5-foot T-posts, post driver, 3 pound single jack sledgehammer, 2-foot rebar
	❏ Combination padlock to secure the transducer on the SS cable in the PVC pipe
	❏ In-situ BaroTROLL® (may be unnecessary depending on geographic area)
	9.0 PROCEDURE
	9.1 Calibration and Pre-installation Procedure
	1. The In-situ Level TROLLs® are calibrated at the factory and no calibration or standardization is necessary before use. Record the serial number and factory calibration date for the pressure transducer on the electronic tracking form (see Appendix 2)
	2. The life of a transducer and how long it will maintain its calibration is dependent upon the duration of use, exposure to extreme environmental conditions, and how carefully it is handled during storage, transportation, and use.  If needed, calibra...
	3. Prior to installation, coordinate with Marshall Baillie, DWQ Monitor, to document PT information and site installation details.
	9.2 Installation
	1. Determine where detailed flow measurements are required and assess the best location to install the stilling well and transducer.  The stilling well should be mounted to a permanent object (e.g., bridge piling) at a location where the channel cross...
	Note: The location for the pressure transducer should avoid areas with: influence of beaver, backwater, sediment build-up, and change in channel cross section.
	2. Using Win-Situ® 5 software, program the transducers to log depth readings every 15 minutes, using the procedure outlined in the software. The Level TROLLs can be programmed to log immediately, or a delayed start may be used.  In either case, ensure...
	3. Based upon the site, determine the length of the PVC pipe that will reach down to low water and ideally above high water.  The transducers are water-tight, so no damage will occur if the top of the pipe is not above water throughout the year, howev...
	4. Using this determined length, cut the PVC pipe to the appropriate length.
	5. Drill a 3/8 in hole for the padlock 2 inches below the top of the PVC pipe.
	6. Drill several holes near the bottom of the PVC pipe to allow for water flow through the system. Also drill holes to insert another bolt. The bolt will be the seat for the PT when deployed.
	7. Using the 3/32 in SS cable and ferrules, make a tether for the pressure transducer inside the PVC pipe (See Figure 1 and Figure 2 for a view of this setup).
	a) Place a ferrule on the cable, run the end through the eyelet on the top of the transducer then through the ferrule again, forming approximately a 2 in loop.  Clamp in place using an assuage tool or the 3-pound sledge and a hard surface.
	b) To determine the location and length of the cable for the transducer in the stilling well:
	i) Lower the transducer into the pipe from the top until the PT hits the bolt at the bottom of the stilling well.
	ii) Pull the transducer up approximately ½ in above the top and mark the cable at the location of the 3/8 inch hole in the pipe for the padlock.
	iii) Form a loop with this mark at the top, and cut the cable with adequate length to make this loop.
	iv) Verify that the transducer will be approximately ½ in above the bottom cap when the padlock is run through the pipe and top loop of the tether, and secure the loop with a ferrule (See Figure 3).
	8. Secure the transducer inside the stilling well by inserting the free end of the padlock shackle through one of the 3/8 in holes at the top of the well, hooking the tether loop over the shackle inside the pipe, then inserting the shackle through the...
	9. Place the top cap on the stilling well.
	10. To attach the stilling well at the determined site, it must be attached so that it will not be dislodged in any high flow events. Below are some examples of different set-ups, however depending on site-specific information, other techniques may ne...
	a) If using a bridge pylon or other vertical structure that extends into the stream as low as the low watermark, the stilling well can be strapped to the downstream side (to minimize wakes caused by the structure). See Figure 2.
	b) If using a vertical surface, such as a bridge abutment at the downstream side where the SS strapping cannot be wrapped around the surface, the 1.5 in metal conduit straps can be used to attach the stilling well.  If the vertical surface is concrete...
	c) If no vertical surface is present, the transducer can be attached to a diagonal surface, such as a stream bank.  The transducer records absolute depth of water, so the stilling well in a diagonal position will not affect readings.  The stilling wel...
	11. A baroTROLL® should be installed along with the pressure transducer. Some sites may not need a baroTROLL® installed alongside a transducer. Refer to the project-specific SAP for more site-specific information. See Figure 6 for a baroTROLL® setup.
	12. Record the date of deployment on the PT tracking form (Appendix 2).
	9.3 Flow Measurements
	In order to establish a strong rating curve, an abundance of flow measurements at the site of the transducer must be taken. Ideally these flow measurements would be taken on a monthly basis, but the following considerations need to be taken into account:
	 A strong rating curve is based on the flow measurements at a variety of flow conditions. Therefore flow measurement sampling should be targeted to measurements of high, regular, and low flow.
	o This is an iterative process that is influenced by the data relationship. For example, if the relationship is lacking low flow measurements, the field monitor should be sure to obtain flow measurements during a lower flow period.
	Any additional information about flow measurement frequency can be found in the project-specific SAP and at the discretion of the DWQ Monitor sampling.
	9.4 Inspection and Maintenance
	1. The transducers should be inspected whenever feasible to ensure no damage, shifting, or vandalism has occurred.  Monitors perform a visual inspection of the gage each time they visit that site.  In addition, the monitor responsible for maintaining ...
	2. The monitor responsible for maintaining DWQ’s gaging stations will determine the frequency at which more detailed inspections of the pressure transducer and inside of the stilling well will be performed.  The transducer can be removed from the well...
	3. Record that an inspection and/or maintenance was performed on the PT Tracking document (Appendix 2).
	4. See Figure 7 for a guide to troubleshooting transducer installation and maintenance.
	9.5 Data Retrieval
	1. To retrieve the pressure transducer, remove the PVC cap and unlock the padlock.  Pull on the SS cable to lift the pressure transducer out of the pipe.
	2. To download the data, remove the protective cap from the transducer and plug it into the laptop using the RS232 Direct Connect cable.  Win-Situ® 5 will recognize the instrument, and prompt the user to connect and download the data.
	3. Make certain the transducer is once again logging at the 15-minute intervals, and reinsert into the stilling well, attaching the tether with the padlock.  The 2 inch loop ensures that the pressure transducer is lowered to the same depth from which ...
	4. Record that data retrieval was performed on the field form (Appendix 2).
	5. Upload data to the DWQ server at this link:
	U:\PERMITS\MONITORS\YEAR_wy_Data\YEAR_wy_PressureTransducerData
	For more information on the data retrieval process, see the operating manual from In-situ® (Section 12.0)
	9.5 Long-Term Deployments
	For long-term deployments, changes in channel cross-sections must be taken into account. Any additional information on this will be detailed in the project-specific SAP.
	10.0 DATA AND RECORDS MANAGEMENT
	 The PT tracking form in Appendix 2 should be included in the site portfolio of every site where a pressure transducer has been installed.  Use this form to record installation of the pressure transducer, inspections and maintenance performed and dat...
	 There is an electronic PT data tracking form (Appendix 3) to detail where the download transducer data is located, and where the flow measurement data is located.  Any flow measurement, if performed for DWQ sampling, has a file where flow measuremen...
	 The Win-Situ® 5 software will store the logged depths and the logged barometric pressures. In-situ® Inc.’s Baro Merge Software will compensate the logged depths for changes in barometric pressure, improving accuracy.
	 The BaroTROLL® is identical to the Level TROLL® except it is deployed in the air.  The BaroTROLLs® record barometric pressure every 15 minutes, and should be downloaded the same way as well, at the same time as the Level TROLLs®.
	 Using flow determinations and the logged depth at the time of flow measurement, a stage-discharge rating curve will be created.  From the curve, an equation can be made that will allow all of the logged depths to be converted into flow estimations. ...
	 The monitor responsible for maintaining DWQ’s gaging stations will determine the frequency at which flow measurements performed specifically for rating curve assessments/adjustments need to be performed.  See Section 9.3 for more information.
	11.0 QUALITY ASSURANCE AND QUALITY CONTROL
	Follow all procedures described in this SOP to ensure valid, high quality pressure transducer measurements.  Follow all procedures described in DWQ’s SOP for Stream Flow Measurement to ensure valid, high quality flow measurements that can be used to d...
	Keep up-to-date equipment maintenance records and calibration data (Appendix 2) with other site records to provide defense of quality data from installed pressure transducers.
	12.0 REFERENCES
	The In-situ® website (http://www.in-situ.com/) has Win-Situ® software updates and helpful Quick Guides, Instrument Manuals, Instruction Sheets and Technical Notes including:
	 Level TROLL  Operator's Manual (https://in-situ.com/us/rugged-troll-100)
	 Win-Situ® 5.0 User’s Guide
	 Technical Note: Using Baro Merge Software
	o (https://in-situ.com/us/support/categories/software-firmware)
	Freeman, Lawrence A., et al. "Use of submersible pressure transducers in water-resources investigations." US Geological Survey, Techniques of Water-Resources Investigations 8 (2004): A3.
	Goering, T. 2008. Pressure transducer installation, removal, and maintenance.  Los Alamos National Laboratory Standard Operating Procedure SOP-5227, Revision 0, Effective Date 10/28/2009. Online at http://www.lanl.gov/environment/all/ docs/qa/ep_qa/SO...
	U.S. Environmental Protection Agency (EPA). 2014. Best Practices for Continuous
	Monitoring of Temperature and Flow in Wadeable Streams. Global Change Research Program, National Center for Environmental Assessment, Washington, DC; EPA/600/R-13/170F. Available from the National Technical Information Service, Springfield, VA, and on...
	Yerington Mine Site. 2009. Pressure transducer water level monitoring standard operating procedure SOP-21, Revision 1, Revision Data 4/28/2009.  Online at http://yosemite.epa.gov/r9/sfund/r9sfdocw.nsf/cf0bac722e32d408882574260073faed/120f26eb0d420d8b8...
	Related DWQ SOPs:  Standard Operating Procedures for Stream Flow Measurement
	13.0 Figures
	Figure 1: Top view of installed pressure transducer.
	Figure 2: View of a pressure transducer attached to a metal sign.
	Figure 3: View of pressure transducer with clamped ferrules.
	Figure 4: View of pressure transducer attached to a bridge
	Figure 5: View of a pressure transducer attached to a tree root.
	Figure 6: View of a baroTROLL® attached to a nearby tree.
	Figure 7: Troubleshooting Guide. Taken from EPA, 2014.
	14.0 APPENDICES
	Appendix 1 - SOP Acknowledgment and Training Form
	SOP Acknowledgement Form
	This SOP must be read and acknowledged annually, and this form must be kept on file at DWQ.
	Please sign below in accordance with the following statement:                                                “I have read and understood the above referenced document.  I agree to perform the procedures described in this SOP in accordance with the doc...
	SOP Training Form
	Training is required for all new samplers and Refreshers are required annually.
	Trainee:  Sign below to acknowledge that training on this SOP was received, understood, and all questions/concerns were addressed by the trainer.
	Trainer:  Sign below to acknowledge that training on this SOP was completed for the individual listed and that trainee is competent to perform the procedures described within.
	Appendix 2: Example. Pressure transducer tracking form

	Appendix 3: Example. Pressure transducer data tracking form
	Appendix 4: Quick Deployment Guide

	PT deployment Instructions
	Setting the Instrument Time
	The instrument time and the current PC time are shown at the top of the screen when an instrument is connected to the software. The PC time appears on the left, the instrument time on the right. Both clocks are updated at 0.5 Hz (once every two second...
	To synchronize the instrument time to the current PC time, click the Clock Sync button. Win-Situ writes the current PC time to the instrument.
	Adding a New Site
	To add a new site to the site database in your working directory do one of the following: On the Data tab, click the Site Data folder, select File> New > Site.
	Or
	On the Home tab, click the Site button  to display the site list, then click New. Enter a name for the site. This is the only required field.
	Click Save to save the new site. The new site will appear in the Site Data folder, and Win-Situ will add it to the site database in the working directory on your computer. It is now available to select for any instrument log.
	Log Setup
	The Log Setup Wizard presents sequential screens to help you supply all the information necessary to set up a data log in the instrument.
	To access the Log Setup Wizard the instrument must be connected to the software.
	1. Click the Logging tab
	2. Click the New button .
	The New button may be disabled or may show a warning if an active log already exists on the instrument, or if the instrument is polling live data (see the Home screen), or if the device already contains its maximum number of logs.
	3. Select the Site where the set of data will be logged and supply a name for the log.
	4. Click the right arrow to continue after each following step, 5-9.
	5. Select the parameters you intend to measure (Pressure in mmHg, Depth in feet, and Temp in Celsius).
	6. Select the logging method (linear) you intend to use.
	7. Select the log interval (15min). A log interval is how often a measurement will be taken and stored.
	8. Select the start condition (a time in the near future), stop condition (usually none), and specify how to handle full device memory (do not overwrite data).
	9. If you selected depth as a parameter to measure, specify how you intend to log this parameter (depth mode does not require that you enter a Level Reference).
	10. The final screen summarizes the log setup. Click the checkmark to write this information to the instrument.
	11. Deploy the device in the stilling well.
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